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INTRODUCTION 

Sterling Trader® Manager is our comprehensive, real-time risk management system, providing the tools you need to 
efficiently manage permission and risk settings for your traders and accounts.  From monitoring real-time profit and loss, 
to managing buying power and exposure limits, Sterling Trader® Manager’s suite of risk controls will help you effectively 
manage your firm’s risk and keep your traders on track.  Here is a quick sample of what you can expect from Sterling 
Trader® Manager. 
 

 Real-Time profit and loss by account and by user-defined groups of accounts 
 

 Real-Time position monitoring of all accounts 
 

 Maximum Loss enforcement, max position and order quantity enforcement 
 

 Detailed buying power and margin controls, assignable per account 
 

 Trading monitors reporting the trading activity of each account 
 

 Assignable commission plans for end of day reporting 
 

 Short-Sale and Odd-Lot controls 
 

 Full front-end DMA order entry 
 

Sterling Trader® Manager also includes trading functionality found in the front-end trader platform, Sterling Trader® Pro, 
so you can watch the markets, make trades for your clients if necessary, or close out positions to cover margin calls or 
other risk situations. 

Confidently manage your business with Sterling Trader® Manager. 
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CHAPTER 1 – TRADER LIST 
 

INTRODUCTION – Because risk management does not take place until log-ins to the trading platform and accounts to 
trade in exist, we will go over the process of setting up traders and accounts.  Traders will be first.   

Traders are set up in the Trader List window.  To access the Trader List window, either select Trader List from the 
“Windows” menu in the Main Menu or right click in the Main Menu and select Trader List. 

The Trader List window lists all of the traders with your firm that are using either Sterling Trader® Pro, Sterling Trader® 
Elite, or Sterling Trader® Manager software. 

        

The Trader List available columns to display can be found in the “View” menu under Settings.  The columns give a quick 
overview of each Trader’s attributes. 

 

 

Select from pre-set 
color schemes 
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EDIT TRADER   

There won’t be anything to see in the columns, however, without adding Traders! 

To add a new Trader: 

1. Click on the “Actions” menu, or right click in the Trader List window and select “Add Trader”.  The “Add Trader” 
screen pops up.  It is a tabbed screen, defaulted to the “General” tab. 
 

     
 

2. Enter the following: 
 Trader – The log in ID you wish to give the new Trader 
 Desc – Description.  This can be anything you would like to us to further identify the Trader.  In the 

example above, we selected the date the Trader was created. 
 Firm – Name of the firm requesting the new user. 
 Type – “Backed” or “Proprietary”. 
 Category – “Trader”, “Manager”, or “Super Manager”.  Traders use Sterling Trader® Pro, Managers use 

Sterling Trader® Manager. 
 Password – The password the Trader will use to log on. 
 Expires – Date to expire the Trader. (If applicable) 
 Status – “Enabled”, meaning the Trader log in is ready for use.  “Disabled” or “Suspended”, meaning the 

Trader will not be able to log on and use the platform.  “Disabled for Deletion”, meaning the trader ID will 
be permanently removed during routine maintenance. 

3. Alternatively, you can import an existing trader as a template by entering the trade name in the Import Trader box. 
4. The User data fields, Notes, and Equity Trading Limits fields are optional and not necessary to complete the 

Trader. 

The remainder of the Trader properties are set up under the following tabs: 

GENERAL – This tab, shown above, is where a manager can create or edit account information. 

Enter an existing 
Trader name here 
and click Import to 
import the settings 
of that Trader 

Description can 
be anything.  
For this demo 
we selected the 
creation date as 
the description 

These are for 
additional info. 
and are not 
necessary to 
create the new 
trader 

Setting these 
will apply to 
all accounts 
linked to the 
Trader 
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PERMISSIONS – Enables various trader abilities, such as allocations, trailing stops, API, and options trading. 

 

 

SUPER MANAGER – If your user is designated a Super Manager, you can assign certain permissions to other Trader 
Managers from this screen.  You can also set a stock watch symbol limit for the selected Trader (You don’t need to be a 
Super Manager to set a symbol limit). 

Trading Regions are set in this tab.  If a trader will be trading any or all offered regions, these boxes must be checked.  
They do not need to be checked if the trader is only receiving data from these regions.  Please note that for Pro users 
there are additional fees per trading region, so a region should not be assigned to a trade without proper approval. 

      

 

 

Enable futures and 
options trading 

Enable API 

Enable trailing stops, 
GTC orders, and 
other special order 
actions 

Enable allocations 
and other special 
trading privileges 

These boxes correspond to the 
tabs found in the Account List 
“Edit Account” screen.  For 
example, Allow Routing 
Maintenance allows the 
selected Trader to use the 
Routing tab.  They are grayed 
out to illustrate that there are 
several permission levels for 
users of Sterling Trader® 
Manager 

Permissions 
specific to Elite 
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ACCOUNTS – Assign accounts that a 
Trader will have linked to it from this 
tab.  To add an account to a Trader 
simply highlight the desired account 
and double left-click on it. 

 

 

 

 

 

 

 

 

 

TRADERS – This tab functions exactly the same as the “Accounts” tab, except you can assign Traders to Managers with 
authority to monitor those traders. 

COMMISSION – This tab also functions the same as “Accounts” and “Traders”, except that you assign pre-set commission 
schedules (created in the back office) to a Trader. 

DESTINATIONS – Assign destinations to a Trader.  Simply check the appropriate box next to each destination.  Please 
note, checking a destination will not make it available in any of the Trader’s accounts.  The routing must also be set up in 
the Account List, which is discussed in chapter 2. 

 

  

This demo account is assigned 
to the selected Trader 
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QUOTES – This tab allows you to assign the quote feeds a user will see.  Simply check the appropriate box next to each 
quote feed (Please see following page). 

 

 

DATA COLUMNS 

Once the new Trader is set up, you will be able to see it in the Trader List window. 

 

 

 

As noted on page 4, you can select columns to view in the “View” menu, under Settings.   

Please note the column shown titled “Attributes”.  This is a catch-all column showing what a trader is enabled for.  This 
saves the need for a spread out Trader List with a separate column for each enabled attribute.  To view a description of 
the attributes each letter refers to, go to the “View” menu and select Trader Attributes Legend.  Or, go to Exhibit B at the 
end of this guide.  Once you are familiar with these letter codes, you will be able to easily check what a specific trader is 
enabled for.  Of course, you can always right-click on a Trader name and select Edit Trader to double check permissions 
as well.  

If assigning quotes to live users, 
keep in mind that each quote 
feed carries its’ own fee 

 

Trader is Enabled, so they are able to log in 
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CHAPTER 2 – ACCOUNT LIST 
 

The Account List window gives you a snapshot of all your accounts and their current settings.  In the screenshot below, 
the Account, Group, Commission Rate, Max Loss, Day Buying Power, and Night Buying Power are listed.  There are many 
more informational columns available, but first we are going to examine the set up screen where that information is 
entered and the accounts are created. 

 

To access the additional columns, click the “View” menu and select Settings.  In the Account List Settings window you 
will be able to select a preset color scheme and columns to display. 

 

To access the Edit Account (or Add Account) window, right click on an account and select Edit Account, or click the 
“Actions” menu and select Edit Account. 

The Add Account window is a multi-tabbed window.  Each tab will be discussed, beginning on the next page.  

 

Looks like the Trader List Settings 
window, only without the smug 
attitude.  Like the Trader List is 
better than everyone else, right? 
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EDIT ACCOUNT   

                 

GENERAL – Create new accounts for trading or edit information of on existing account.  New accounts can be created 
from scratch, or a previous account may be imported as a template. 

To create a new account from scratch: 

1. In the Account List, right click and select “Add Account”.  (Brings up same screens as Edit Account). 
2. Name the account. 
3. Select the Instrument the account will trade.  (Equities and options, Futures, etc.) 
4. Select the Status. (Enabled by default) 
5. Select the Type (Agency or Principal), Class – such as Margin or DVP – and Origin. 
6. Enter a base currency. (especially important for accounts trading multiple regions, where the currencies differ) 
7. Enter a description of the account 
8. Enter the Back Office account (for clearing purposes) as well as the Group the account will belong to. 
9. Click OK. 

All those fields must be filled in to successfully create the account.  Once that is done, the permissions in the remaining 
tabs can be set. 

To import an account as a template: 

1. In the “From” box on the bottom right of the General tab, select the account to use. 
2. Click the Import button. 
3. This template will carry over risk and commission settings 
4. Make any necessary changes and click OK. 

 

Account basics, 
such as what 
instruments can 
be traded and 
whether the 
account is 
enabled or not 

Tabs for the 
various Risk, 
Routing, and other 
settings 
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FEES / COMMISSION – Enables creation and assignment of commission plans.  Commission plans are set up by Sterling 
Support, in a separate application, at the request of the Broker, but managers may input a basic plan, such as .01/share 
with a 3.00 minimum. 

 

RISK (EQUITY) – Controls rule enforcements for short and long selling, as well as odd-lot and mixed-lot transactions for 
the account being created or edited. 

                                

. 

 

 

 

Commission 
schedule that can 
be manually set up 
for each account 

Preset commission 
schedule (set up 
per broker request) 

These settings 
control whether 
or not an account 
can submit odd-
lot and/or mixed-
lot transactions 

Permissions the 
Locatestock.com window 

Wash trade controls  

Min/Max symbol close price refers to the 
previous day’s close.  If selected, traders can’t 
enter orders for stocks that closed above or 
below the entered price 
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The following screenshot from the Risk(Equity) tab defines the Short sale / Long sale rules: 

 

   

Explanation of Short/Long sale position rules enforcement in regards to Strict with Splitting:  Strict with Splitting 
for Short Sale means – Split sell long orders into sell long and sell short orders if order quantity exceeds current long 
position.  Strict with Splitting for Long sale means – Split sell short orders into sell long and sell short orders if order 
quantity exceeds current long position. 

 

RISK II (EQUITY) – Controls buying power for equities and options.  There are two options, Buying Power Control or 
Margin Control.  We’ll discuss both, but first there is Net liq/maint excess. 

Seen below, “Net liquidating / maintenance excess” is the basis for all buying power calculations.  For Buying Power 
Control, it is the number multiplied by the Day and Night multiplier.  For Margin Control, it is the number reduced by the 
appropriate percentage of each order.  These are detailed next.  

 

  

Checking “Passive” for Short Sale rules enforcement will 
allow an account to go from long to short on a position 
with one sell order.   

Checking “Strict” will STOP an account from going long to 
short on one sell order. 

 

 

Net liq/maint excess 
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Buying Power Control – Enable a buying power figure and a multiplier.  For example, an account could have $50,000 
USD buying power with a 4x multiplier, meaning a total of $200,000 USD buying power.  There is day and night buying 
power, night meaning after the core market session closes.  It is important to note that the buying power is calculated off 
the Net liq/maint excess.  So clicking the Update BP button will multiply the Net liq/maint excess by the multiplier. 

              

 

Margin Control – If Enable Margin Control is selected instead of Buying Power Control, you will have to set up how 
stocks and options are margined both on the buy and the sell side (selling refers to short selling for stocks).  Total margin 
available will be the Net liq/maint excess. 

 

To add Margin for equities: 

1. Click Add.  The Add Margin Price Tier screen pops up. 

 

2. Select Equity as the instrument. 
3. Select a price “and up”.  In the example above, it’s all stocks $5.00 and up. 

Check this box to 
include open orders 
in BP calculations 

Night BP 

Clicking UPDATE BP 
multiplies the Net 
liq/maint excess  by 
the Day Multiplier  
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4. For “Margin required” you can select % of market value, or $ per share.  In this example we chose 25% of market 
value. 

5. You can add further margin requirements by checking “Plus” and selecting the additional requirement. 
6. Click OK.  The new requirements will now show under the Risk II (Equity) tab. 

In this example, stocks $5.00 and up are set to charge 25%.  To set margin requirements for stocks priced 0.00 – 4.99, 
repeat the above steps and select 0.00 for the price.  Set margin requirement at 100% or whatever is desired. 

To set margin for options, repeat the above steps, but select options as the instrument. 

The Net Liq/Maint Excess number is reduced for each trade by the percentage entered in the Margin Control scheme. 

Use Leveraged ETF margin control (Equity) – Refers to FINRA regulations for 2x and 3x margin on leveraged ETFs. 

Use Canadian margin control rules – For traders residing in Canada. 

RISK III (EQUITY) – This tab enables a manager to control, to an extent, how much loss an account can generate intraday.  
There are two choices, P/L Control and Balance Control.  Both may be activated at the same time. 

 

With “Enable P/L control” checked and a maximum loss figure entered, a manager can select an automatic course of 
action should that max loss figure be exceeded.  In this example, max loss is set at $2500.  If the account loses more than 
$2500 it will be set to allow only closing transactions and cancelling of open orders. 

With “Enable balance control” checked, an account falling below the set minimum balance will trigger an automatic action 
set by the manager.  Per the screenshot above, only a warning message will be displayed. 

SYMBOLS – Allows a manager to set up limits on a per-symbol, or all symbol, basis. 

 

In this screenshot, the maximum MSFT position account JETEST1 can hold is 7000 shares.  The maximum quantity of 
any order entered in MSFT is 500 shares. 

  

Check to included 
Unrealized P/L in 
calculations 
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To set up symbol limits: 

1. Right click in the window and select “Add” or click the “Add” button on the bottom of the screen.  The Add symbol 
Control screen pops up. 

 

2. Enter a symbol. 
3. Select from the following limits: 

 
 Max Position:  The total shares an account may hold of the selected symbol. 
 Max Position Value:  The total dollar value the account may hold of the selected symbol. 
 Max Order Quantity:  The total share amount that can be traded at one time in the account. 
 Max Order Dollars:  The total dollar value allowed for each order. 
 Max Open Orders Per Side:  Total number of open buy or sell orders allowed at any given time. 
 Day Multiplier:  If the account is using Buying Power Control, you can give the account a lower multiplier 

specifically for the selected symbol 
 Night Multiplier:  Same as Day Multiplier. 

 
4. Click OK.  The parameters selected above (For IBM) now appear under the symbols tab. 

 

The account can hold $15,000.00 worth of IBM and each order may be only up to 200 shares. 

5. A manager could set limits for ALL symbols by entering * in the symbol box of the Add Symbol Control screen. 
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RISK (OPTIONS) – The additional settings this tab lets a manager control are specific to options.  You can set a maximum 
number of contracts an account can hold (applies to all option contacts) and a max order quantity, give an account the 
ability to sell to open and enter simultaneous buy and sell orders on the same symbol. 

 

 
 
ROUTING – Select which routes to give an account by checking the box next to the corresponding destination. 
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RISK (FUTURES) – Control margin, max loss, and minimum balance for futures.  These features are similar to the controls 
under Risk III (Equities) tab.  For futures trading, there is no buying power with multiplier.  There is only the Margin Control 
option. 

 

 

CONTRACTS – Control the margin requirements, maximum position, and maximum quantity for futures contracts.  This 
window functions the same as the equities “Symbols” window. 

 

To add a contract 

1. Click the “Add” button on the bottom left of the screen.  The Add Contract Control screen pops up (see following 
page). 

2. Enter a contract root, such as ES. 
3. The current margin populates automatically.  You can then select the Margin% desired (Margin% is the 

percentage of the margin requirement per the exchange for that product). 
4. Select a max position and max quantity per order, if desired. 
5. Click OK.  The contract shows up in the Contracts screen.  Please note, you must check Enable Position Limit 

and Enable Order Size Limit shown above to set those in the Add Contract Control screen. 

  

Check these to enable position and order size limits 
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DELETE ACCOUNT – To delete an existing account, right click on the account row and select “Delete Account”. 

 

DATA COLUMNS 

There are many more columns available to view in the Account List window once you have completed adding accounts. 

             

This is a small sampling of data you might want to see when checking how your accounts are set up.  The Attributes 
column is similar to the Trader List Attributes column.  The letters are explained at the end of this guide.  Or you can click 
on the “View” menu and select Account Attributes Legend. 

Both the Trader List and Account list are primarily to show you what accounts you have and the settings for those 
accounts.  Real-Time risk is managed from the Main Menu of Sterling Trader® Manager.  

25% margin – also referred 
to as quarter-margin 
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CHAPTER 3 – MAIN MENU 
 

The Sterling Trader® Manager Main Menu is your gateway to the management functionality available in the platform.  The 
window consists of the menu headings, the icons for opening trading windows, and the list of current accounts for 
monitoring risk. 

This Chapter will only be concerned with the menu headings and other general functionality.  Using the Main Menu in a 
risk control environment will be the key to Chapter 4. 

       

 

Please note, the icons beneath the menu headings are quick links to open the trading windows found under the 
“Windows” menu.  Those windows are the same as those found in Sterling Trader® Pro.  Please review the Sterling 
Trader® Pro user guide for the functionality of those windows.  The only exceptions are the Group Risk and Options Risk 
windows.  Group Risk is available only in Sterling Trader® Manager and Options Risk is not discussed in the Sterling 
Trader® Pro user guide. 

The rest of this chapter will flow as follows, 

1. Individual menu headings 
 

2. Group Risk 
 

3. Options Risk 
 

4. Special features of the Position Summary and Trading Monitor windows in Sterling Trader® Manager.  
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MENU HEADINGS  

There are six menu headings, Actions, Filter, Edit, View, Windows, and Help.  Each provides valuable functionality in the 
Main Menu. 

ACTIONS MENU – The “Actions” menu features the links to create or restore a backup of your current settings or restore 
a backup, or manage the open windows.  Please see below. 

 

 

If you create a backup of your settings, we recommend saving to a folder not related to Sterling Trader® Manager. 

FILTER MENU – In this menu you can remove current filters on the account list, save the current filter, or load a previously 
saved filter.   

Filters are criteria you choose to select what data you will view within a window, in this case the Main Menu.  You select 
filter criteria by column.  For example, if you had more than one group, you could filter by the Group column to view one 
particular group only.  Or you could filter by the $Total P/L column by filtering out all positive numbers, so you could see 
only the accounts currently with a negative P/L.  However, you can’t create a new filter from this menu because the filters 
are created by column.  Therefore, you may find it more convenient to disregard the “Filter” menu in favor of right-clicking 
on a column heading, which will give you the same options of the “Filter” menu PLUS the ability to create a new filter 
based on that column.  Here is the pop-up menu if you right click on a column heading. 

 

Please see the following page for examples on how to create a new filter. 

 

To create a filter: 

1. In this example, we will filter by $Unreal (Unrealized P/L).  First, right click on the $Unreal column. 

Minimize or restore all windows to their position.  
Clicking on Close All will exit the program 
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2. Select “Add/Edit Filter”.  The add/edit screen pops up. 

 

3. In this example we selected a condition where $Unreal is <= -200 are the only values that will show in the 
window.  Notice that this filter is by Value.  That is because the $Unreal column is a number column.  Columns 
with text in them will allow you to filter by specific text or preset List. 

4. After you have chosen the condition, click Filter. 
5. Your window will now be filtered by your condition (see next page). 

  

Right-Click on $Unreal 
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The accounts now showing are only the accounts with an unrealized P/L of less than or equal to -200 ($200.00 loss). 

 

 

EDIT MENU – In the “Edit” menu you can copy all or selected data in the main menu window to clipboard.  That data can 
then be pasted to another application, such as Excel. 

VIEW MENU – Available options in the “View” menu depend on what you are permissioned for.  Here is a rundown of the 
menu and a brief description of each link. 

 Login Status will list all your users and their log in status, including what software version they are on, if they are 
logged in, and, if not, when they last logged in.  In this case TRADER ABC is on version 5.3.4 and is currently 
logged in.  By clicking the Logout button on the bottom right, TRADER ABC can be logged out of the platform. 

    

 Easy-To-Borrow Lists – There are two choices, Maintenance and Reload.  Reload allows you to select a current 
ETB list and reload it.  Maintenance, shown on the next page, allows you to update a list for a specific symbol 

Only one 
account fits the 
criteria at this 
time.  If more 
accounts fall 
below 200, they 
will populate the 
list 
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 Execution Destinations – Lists all the routing options available to your firm.  New destinations can be added by 
clicking the “Add” button. 
 

 Commission Schedules – Lists all commission schedules on file with a description of each one, including any 
group the rate is assigned to.  You can add a new commission schedule by clicking the “Add” button in the 
Commission Schedules screen and selecting the desired rates 

 

 Interest Rates – Shows the current interest rate.  It is not a real-time function, so the data can be manually 
updated. 
 

 Spreads – Create spreads to monitor the price difference between two stocks or option contracts.  Please see the 
Sterling Trader® Pro user guide for this functionality. 
 

 Symbol Lookup – Look up a symbol by company name, or a company name by symbol. 
 

 Settings – Brings up the Global Order Entry settings.  These settings are exactly the same as the settings in 
Sterling Trader® Pro, with two exceptions.  Those exceptions are listed below.  Please consult the Sterling 
Trader® Pro user guide for the remaining Global Order Entry settings.   

Please note, Hot Keys do not function in Sterling Trader Manager, so that screen is grayed-out. 

1. Select a List. 
 

2. Type in a symbol and click Query to see if it is in the 
list.   
 

3. If it’s not, enter a quantity of available shares and 
click Set.   
 

4. If it is in the list, you can change the number of 
available shares and click Set. 
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The special Global Order Entry settings for Sterling Trader® Manager are in the Manager folder in the settings menu.  The 
settings screens are “General” and “Highlighting”.  General is shown below. 

 

In the General screen you can set what columns you want to see in the Main Menu.  Simply check or uncheck the box 
next to the desired column.  You can also select the color scheme and other visual options, as well as the Double-click 
event setting.  Please note the settings for updating Manager.  The update times are important as you will be viewing 
client account balance data, so you need to set the update time to a time you are comfortable with. 

For column descriptions, please see Exhibit A. 

  

Update Manager = 
how often an 
account’s P/L and 
other balances will 
update on the 
Main Menu 
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 Highlighting – A risk management tool. 

 

There are several options for highlighting for risk.  Above you will see options to highlight rows or columns based on 
percentages of buying power used and loss sustained.  If an account meets any of the percentages you set, they will be 
highlighted in the specified color on the main menu. 

 Server Info keeps track of what IP and Port you are connected to should you run into a technical issue and need 
to call support. 

WINDOWS MENU – The “Windows” menu offers the same direct access real-time trading screens as the windows menu in 
Sterling Trader® Pro, except that the data applies to all accounts linked to the Manager.  So, a position summary window 
will list all the positions of every account linked to that Manager, a trading monitor will show all trades for all accounts.  
Please consult the user guide for Sterling Trader® Pro for the basic functionality of these windows.  The exception is the 
Group Risk window, available in Sterling Trader® Manager, and some extra features in Trading Monitor and Position 
Summary.  Group Risk is discussed next.  Trading Monitor and Position Summary will follow in a later chapter. 

GROUP RISK  

This window gives you a snapshot of buying power currently being used on a group level.  In the Sterling risk system, 
accounts are assigned to groups.  One firm may have several groups of accounts.  In the Main Menu window, you see all 
the accounts individually.  In the Group Risk window, you view whole groups on one line.  You can combine more than 
one group into a group risk entry. 
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When you first bring up the Group Risk window, it will be blank.  Click on the actions menu and select “Add Group” to start 
adding groups to the list. 

 

The Master Group Setup window pops up with the groups you can choose from.  In this example, there are two test 
groups. 

To set up a new Master Group: 

  

1. Name the Master Group – this one is named New Group, but 
you can select whatever name you prefer. 

2. Enter a buying power figure.  This is not binding on the group, 
but only used for monitoring purposes. 

3. Check all the groups you want included in the master group.  It 
can be one group or up to all groups. 

4. Click OK 
5. The group created now shows up on the Group Risk window. 

(see following page) 
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The columns shown above are the only columns available in the Group Risk window.  They are: 

 Master Group – The groups you have created. 
 

 $Buying Power – Total buying power for the group as assigned in the Master Group setup window.  As a 
reminder, the buying power here is not enforced on the accounts in the group, it is for monitoring purposes only. 
 

 $BP Used – The total buying power currently being used. 
 

 $Max BP Used – This number reflects the largest amount of BP used on the day.  So, if the $BP Used currently 
is 29K, but earlier in the day the group had 200K in use at one time, than 200K would show in the $Max BP Used 
column. 
 

 %BP Used – The percent of the total BP that is currently being used. 
 

 $Real – Realized Profit / Loss. 
 

 Total Qty (Total Quantity) – Total shares bought and/or sold short intraday (does not include previous day’s 
trades). 

In the “View” menu you can select Settings to set the criteria for highlighting a Master Group.   

 

Now, any Master Group will highlight if Warning or Critical percentage is met. 
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OPTIONS RISK  

Options Risk looks at stocks and the option contracts that have been bought or written against those stocks as a whole 
position.  This information is used to enable an auto-hedge function.  Take a look at the below example. 

 

Accounts JETEST1 and JETEST2 hold 300 shares of IBM each.  However, the Position Delta is very different for each 
account.  If you right-click on the first IBM position, you can select Details from the pop-up menu.  The Position Summary 
window pops up for this position.  As you can see, this account is long 3 IBM calls.  So, both IBM and the calls IBMGB are 
factored in to the one-line quote in Options Risk. 

         

The account JETEST2 has written 3 covered calls against their IBM position, which is why the position delta differs from 
the IBM position that also carried 3 long call options.  The difference in these strategies corresponds to the difference in 
Pos Delta and the P/L numbers. 

These option positions are bundled with the underlying stock in the Options Risk window to give the manager a complete 
overview of the entire position.  The columns shown above in the Options Risk window are the total columns available 
with the exception of AH (Auto-Hedge, which, by design, does not function on Manager).  They can added or removed 
from the “View – Settings” menu. 
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POSITION SUMMARY and TRADING MONITOR SPECIAL FEATURES 
 

This section is a quick look at the special features available in Sterling Trader® Manager Position Summary and Trading 
Monitor windows.  These features allow you to adjust individual positions and trades and are only available in the right-
click pop-up menu.  These are the functions: 

 Position Summary – Opening Position 
 

 Trading Monitor – Maintenance 
 

 Trading Monitor – Maintenance Close Selected 
 

Opening Position – Allows you create a new position or adjust a current one.   

To create a new opening position: 

1. Right click on any position and select “Opening Position – Create” from the pop-up menu.  The Create Opening 
Position screen pops up. 
 

           

 

2. Select the account. 
3. Enter the Symbol, Instrument, Opening Position quantity, and Opening Price (Mark to MKT not necessary). 
4. Click OK and the new position will show up in the Position Summary for the selected account. 
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To adjust an opening position: 

1. Right click on the position you want to adjust.  In this case we’ll select the 500 INTC we just added.  Select 
“Opening Position – Adjust”.  The Adjust Opening Position screen pops up. 
 

     
 

2. Adjust the Opening Position volume, or the Opening Price, or Mark to MKT.  In this example we adjusted the 
position quantity from 500 to 300. 

3. Click OK.  The position is now adjusted. 

 

Maintenance – Adjust the details of an intraday trade. 

To perform Maintenance on a trade: 

1. Right click on the desired trade in the Trading Monitor window and select Maintenance...  The “Order 
Maintenance” window pops up for the selected trade. 
 

 
 

Only the lower 
two boxes can 
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2. There are two choices in the “Action” box.  Change and Close.  After that, you can update any part of the order 
except for the destination.  For example, say the fill price above in AMD came back from the exchange in error 
without the decimal point (373 instead of 3.73).  Using Order Maintenance, you could adjust the price correctly.  
You could also send the order to another account by changing the account selection box. 

3. When completed, click the “Send” button. 

Maint Close Selected – Should an account have an order that is showing live but it is actually cancelled (and an out has 
been received from the exchange), use Maint Close Selected to close the live order.  Right click on the order and select 
Maint Close Selected.  Click yes and the order will close on the platform. 
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CHAPTER 4 – MONITORING RISK 
 

At last, we get to the main menu window – Here you will find the list of each individual account under your firm.  There are 
over 40 columns of data to choose from for monitoring account status and risk.  You can also disable traders from this 
window or re-enable previously disabled traders.  Please note, values that are dependent on the market (such as Max 
Loss) will be affected by quotes on Sterling Trader® Manager. 

In the screenshot above you will see some basic data.   

 There are six equity accounts and one futures account.  
 

  They are divided up into two groups, JETEST and JEFUT. 
 

 You can see Current Net Liquidity, Net Quantity of shares owned, Realized P/L, Unrealized P/L, Total P/L, Total 
Exposure, and operating status of each account.  One account is disabled, meaning no trading is allowed, two 
are set to Close and Cxl Only, meaning only closing transactions and cancelling of current live orders is allowed. 

Additional columns can be added or current columns hidden by going to the View menu, selecting Settings, and selecting 
the General link under the Manager folder as shown on page 8. 

The status of each account can be quickly changed by right-clicking on an account and selecting “Account status”, then 
Enabled, Disabled, or Close/Cancel Only. 
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Other right-click features are: 

 Adjust Net Liquidity – Change the maximum margin an account can take on intraday. 
 

 
 
If an order would cause the account to exceed the 250K Net Liquidity, the trader will get a reject message 
(assuming the trader has set up the notifications for rejected orders).  Keep in mind that in this example the Net 
Liq. Is 250K, but that number can be modified by the buying power controls discussed in Chapter 3. 
 

 
 

 Adjust Max Loss – Change the maximum loss an account can generate intraday. 
 

 
 
An account can be set to automatically switch to a status of Close and Cancel Only if Max Loss is exceeded. 
 

 Position Summary – Open a Position Summary window for the highlighted account.  A manager can manage an 
accounts positions from this window (buy and sell just like the Position Summary window in Sterling Trader® Pro).  
A Manager could also allocate trades from this window if they don’t allow the trader to allocate. 
 

 Trading, Futures, and Options Monitor – Open Trading Monitors for the highlighted account. 
 

 Trader List – Opens a window to view all traders and adjust permissions for those traders (see Chapter X). 
 

 Account List – Opens the Account List window, allowing editing of risk settings for accounts (see Chapter X). 

Net Liquidity adjusted to $250,000.00 

Max Loss adjusted to $750.00 

Calculates margin 
already used plus 
margin the order uses 
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These features enable managers to effectively monitor their accounts and make quick decisions by providing, in real-time, 
the margin, P/L, and exposure information necessary to make those decisions, and the tools to execute.  Here is an 
example. 

Manager A manages account JETEST6.  The account is set up with margin capabilities based on Buying Power Control 
(discussed in chapter 2).  The account balances are: 

 Liquidating Equity - $25,000.00 
 

 Day Buying Power - $100,000.00 
 

 Night Buying Power - $50,000.00 
 

 Positions – Zero, the account is flat 

In the Sterling Trader® Manager main menu, the Manager has selected the following information: 

 

The Manager has enabled P/L Control in the Edit Account screen, but sees there is currently no Max Loss amount set.  
The Manager right clicks on the account, selects “Adjust Max Loss” and sets it to $1,500.00.  Please note, unless Max 
Loss settings are enabled in the Account List, adjusting Max Loss in this window will have no effect on the account. 
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The trader proceeds to place several opening orders intraday, which can be seen in the Trading Monitor.  These are all 
buys to open long stock positions for this example. 

 

Sterling Trader® Manager is updated accordingly. 

 

 

 

Let’s say the market goes against this trader.  Sterling Trader® Manager reflects this in the Total P/L column (and the 
Realized and Unrealized P/L columns if selected).  Total P/L has exceeded Max Loss, so the account switches to a status 
of Close, Cxl Only. 

 

  

Trader has purchased 
$45,557.00 worth of 
stock and is currently 
down 149.50 (not 
including commissions) 

 

BP used and BP left 
are adjusted 
accordingly per the 
trades executed 
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The trader receives the following notification: 

 

If a trader found themselves in a risk situation where positions needed to be covered immediately, regardless of the 
account status, a manager could double click on the account in Sterling Trader® Manager to bring up the Position 
Summary for that account and close out the positions if necessary, either one by one or using the right click menu to close 
them all. 
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EXHIBIT A 

Main Menu Column Definitions 

Acct Account Number (May include text or numbers) 

Group 
Group the Account is set up under (This is especially 
handy if you want to filter accounts by the groups they 
are in) 

Description 
Description of account.  For example, "Bob's Trading 
Account" 

Net Qty 
Aggregate total shares (Long minus Short) currently 
open 

$Real Realized Profit and Loss 
$Unreal Unrealized Profit and Loss 
$Total P/L Total Profit and Loss 
Qty Bot Total shares bought intraday 
Qty Sld Total shares sold Intraday 
$Bot Dollar amount bought intraday 
$Sld Dollar amount sold intraday 
Tkts Bot Total buy orders executed intraday 
Tkts Sld Total sell orders executed intraday 
Tlt Opg Pos Total aggregate shares beginning of day 
Tlt Lng Qty Total outstanding shares long intraday 
Tlt Shrt Qty Total outstanding shares short intraday 
$Long Exp Long Exposure = Long market value 
$Short Exp Short Exposure = Short market value 
$Total Exp Long plus Short market value 
$Net Exp Aggregate Market Value (Long minus Short) 
Qty SLng Quantity Sold Long - Total shares sold in Long Sales 
Qty SShrt Quantity Sold Short - Total Shares sold in Short Sales 
$Sld Lng Dollar amount sold long 
$Sld Shrt Dollar amount sold short 
Tkts SLng Number of orders executed that were long sales 
Tkts SShrt Number of orders executed that were short sales 
Total Qty Quantity Bought plus Quantity Sold 
$Net Liq Net Liquidity 

Leverage 
Net Liquidity percentage of total market value (Current 
Net Liquidity times the Leverage should equal current 
market value) 

Activity Total number of tickets executed intraday 
$Cur Net Liq Current Net Liquidity - $Net Liq plus or minus P/L 
$Mrgn Eqty Margin Equity 

Inst 
Instruments the account can trade (Equity refers to 
both equities and options, but an account may not be 
approved for options) 

$Balance Same as $Cur Net Liq 
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Status Status of account (Enabled, Disabled, etc.) 
$Day Buy Pwr Intraday buying power 
$Night Buy Pwr Post-market buying power 
$BP Used Buying Power Used 
$BP Left Buying Power remaining 

$Exp Left 
Exposure Left - difference between buying power and 
current market value 

$Daily P/L Average Daily Profit and Loss 
$Surplus Exchange Surplus - Manager defined 
$Margin Same as $Net Liq 
$Max Loss Maximum Loss allowable intraday 

$Mrgn Rel 
Margin release for closing overnight positions (Applies 
to Canadian margin rules 
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EXHIBIT B 

TRADER ATTRIBUTES 
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EXHIBIT C 

ACCOUNT ATTRIBUTES 
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